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1. Benvenuti nell'help COPA-DATA 

GUIDA GENERALE 

Nel caso in cui non abbiate trovato delle informazioni che cercavate o se avete dei consigli relativi al 

completamento di questo capitolo dell'help, mandate una Mail a documentation@copadata.com 

(mailto:documentation@copadata.com). 

 

 

SUPPORTO ALLA PROGETTAZIONE 

Se avete delle domande concernenti progetti concreti, potete rivolgervi per E-Mail al 

support@copadata.com (mailto:support@copadata.com). 

 

 

LICENZE E MODULI 

Nel caso in cui doveste constatare che avete bisogno di altri moduli o licenze, rivolgetevi ai nostri 

dipendenti all'indirizzo sales@copadata.com (mailto:sales@copadata.com). 

 

2. Licenza 

Per poter usare zenon come editor/runtime, il prodotto deve essere provvisto di una licenza. Finché non 

si dispone di una licenza valida per zenon, esso funziona solo nella Modalità Demo (A pagina: 6).  

Per procurarsi una licenza per zenon: 

1. aprite Start -> Tutti i programmi -> COPA-DATA -> Licensing 

oppure 

mailto:documentation@copadata.com
mailto:support@copadata.com
mailto:sales@copadata.com
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aprite nell´Editor di zenon, File ->Configurazione generale -> Registrazione prodotto...  

oppure: 

cliccate nello Startup Tool sul pulsante Tools -> Licensing -> Start 

2. Si apre il dialogo per l´ inserimento dei dati licenza.  

3. selezionate zenon Editor/Runtime 

4. inserite il numero di serie e quello di attivazione  

Trovate i dati relativi: 

 sul Vostro documento di licenza 

 sull´adesivo di licenza 

 nel file di licenza License.txt  

Percorso Vista/7/8: C:\Users\Public\Documents\zenon_Projects\  

 attenzione alle lettere maiuscole e minuscole quando inserite il numero! 

5. Dopo il riavvio dell´editor/del runtime, usate zenon con la licenza indicata. 
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Parametri Descrizione 

Editor/Runtime Attivo: la licenza vale per l´Editor di zenon e/o il Runtime di zenon. 

Web Server Attivo: la licenza vale per il Webserver di zenon. 

Numero di serie Numero di serie della licenza  

Nel caso in cui dovesse già esistere una licenza, ne verrà visualizzato il 

numero. 

Numero di attivazione Numero di attiivazione della licenza  

Nel caso in cui dovesse già esistere una licenza, ne verrà visualizzato il 

numero di attivazione 

OK Riprendi dati e avvia zenon  la prossima volta con questa licenza. 

Annulla Rifiuta inserimento e usa zenon con la licenza valida finora o senza 

licenza. 

Richiedi licenza soft. Apre l´assistente per la richiesta di una licenza soft. 

 
 

3. Demo Modus 

Se l'Editor non è stato registrato, esso funziona in Demo Modus Se il Runtime non è stato registrato, 

esso funziona in Demo Modus 

Demo Modus Condizioni 

Editor: l´Editor funziona: 

 per le prime 40 volte in cui viene avviato: per 30 minuti  

 dalla 41° alla 50° volta. Inizio: 20 Minuti 

 dal 51° start: 10 Minuti 

Runtime Un Runtime non provvisto di licenza funziona per 30 giorni o può essere avviato per 40 

volte, a seconda di quale sia il limite che viene raggiunto per primo.  

A partire dal 41° start oppure dal 31° giorno, il Runtime funziona solamente per 10 

minuti. 

Ad ogni start viene visualizzata una segnalazione che indica che il sistema funziona in modalità Demo.  
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 questo comportamento di versioni non provviste di licenza vale anche per il Workbench e il 

Runtime di zenon Logic. 

 

4. Informazione sulla versione 

Potete verificare quale licenza state usando attualmente e quali moduli sono inclusi in essa nella videata 

iniziale al momento dello start di zenon, oppure cliccando su Info su... nel menù Guida:  

 

Parametri Descrizione 

Versione editor Numero di versione dell´editor 

Numero di serie Numero di serie della licenza 

Numero di attivazione Numero di attiivazione della licenza 

Tempo di scadenza (opzionale) Nel caso di licenza limitata nel tempo, informazione a proposito 

della data di scadenza della licenza. 

Campo con moduli: informazione sui moduli per i quali si dispone di una licenza. 

Nel menù Guida  è possibile, selezionando Info su.. aprire una finestra di dialogo dove vengono 

riportate le informazioni sulla versione di zenon e sulla registrazione licenza.  
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5. Scelta della licenza dalla dimensione desiderata 

Le licenze per l'Editor e per il Runtime vengono calcolate in base al numero dei TAG o IOs utilizzati 

CALCOLO SULLA BASE DI TAGS 

1 TAG corrisponde a 1 variabile. Per la determinazione dell'ampiezza della licenza viene considerata la 

somma dei TAG dei seguenti driver. 

 driver PLC e bus. 

Nono vengono contate le variabili di: 

 Driver Interno 

 driver di sistema 

 driver matematico 

 driver di simulazione 

Potete ottenere la licenza per TAGs per l'Editor e il Runtime secondo i seguenti livelli: 

 64 TAG 

 128 TAG 

 256 TAG 

 512 TAG 

 1.024 TAG 

 2.048 TAG 

 4.096 TAG 

 8.192 TAG 

 16.384 TAG 

 65536 TAG 

 Illimitata 

E' possibile effettuare in ogni momento un update della licenza per avere un numero di TAGs maggiore. 
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CALCOLO SULLA BASE DI IOS 

Le licenze possono essere concesse anche sulla base di  I/Os. Per la determinazione dell'ampiezza della 

licenza viene considerata la somma dei IOs dei seguenti driver. 

 driver PLC e bus. 

Nono vengono contate le variabili di: 

 Driver Interno 

 driver di sistema 

 driver matematico 

 driver di simulazione 

Tipo di dato Valore bit 

1 Bit :   1 I/Os 

1 Byte   8 I/Os 

1 WORD 16 I/Os 

1 DWORD 16 I/Os 

1 Float 16 I/Os 

Lunghezza string (max. 64 

caratteri) 

16 I/Os 

Nel caso in cui non doveste trovare il tipo di dato desiderato in questa lista, dipende dal tipo di driver 

prescelto. Alcuni driver, infatti, adottano una denominazione specifica dei tipi di dato. Informazioni più 

dettagliate su questo argomento le potete trovare nella documentazione del driver che state usando. 

Quest'ultima la trovate o nella guida in linea alla voce Driver, o nel file PDF sul nostro supporto di 

installazione; potete anche scaricare detta  documentazione dalla nostra Website  

www.copadata.com (http://www.copadata.com). 

http://www.copadata.com/
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  Esempio 

96 valori binari e 20 analogici numerici devono essere visualizzati in zenon: 

Moltiplicate i 20 valori numerali per 16 e otterrete 320 I/Os. Sommate questi ultimi ai 96 

valori binari. Ottenete il risultato 416 I/Os, che è alla base per la scelta della grandezza di 

licenza. 

Nella riga di stato della Sezione lista  delle variabili possono essere lette le seguenti informazioni: 

 

 Quanti I/Os sono utilizzati attualmente 

 Quanto I/Os hanno una licenza 

 Un esempio: 

 3799/550/1: 3799/550/1:  ci sono 3799 inserimenti; grazie ad un'operazione di filtraggio ne 

vengono visualizzati solo 550; un inserimento è marcato. 

 Per il progetto 22730 c'è un numero illimitato di variabili con licenza. 

NOTA: LICENZA CLIENT. 

Potete usare licenze Client, deve verificarsi quanto segue: 

 il progetto di partenza deve essere un progetto Standalone o un Client  

 se il progetto di partenza non è un Client, esso deve usare al massimo 64 tag che necessitano di 

una licenza 
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 tutti i sottoprogetti devono essere Client  
 

6. Tipi di licenza 

Potete ottenere la licenza per zenon in modi diversi: 

 Licenza soft (A pagina: 12): domanda al momento dello start dell´editor o del runtime un numero 

di identificazione PC univoco.. 

Caratteristiche: 

 La licenza non può essere sottratta. 

 La licenza è legata al computer. 

 Un tipo di licenza pratico soprattutto per i computer portatili. 

 Licenza dongle (A pagina: 13): Domanda al momento dello start dell´editor o del runtime un 

dongle hardware alle interfacce parallele o USB.  

Dongles sono a Vostra disposizione come: 

 Dongle sul posto di lavoro singolo: 

 Dongle di rete: Su un dongle centrale in rete viene considerato un certo numero di 

licenze, che possono essere usate nello stesso tempo come licenze concurrent use.  

Caratteri di dongels: 

 Facilità d'uso. 

 La licenza può essere trasmessa da un computer all'altro disconnettendo la 

componente hardware dongle da un calcolatore e connettendola all'altro o in rete. 

 Non ci sono problemi in caso di un problema che riguarda il disco fisso. 

  Informazioni su 

Se non esiste una licenza valida oppure sono state assegnate tutte le licenze disponibili in 

rete, allora l´editor o il runtime si avviano in Modalità Demo (A pagina: 6). 
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6.1 Licenza software 

La licenza soft assegna ad un computer un´identificazione inequivocabile. Determinate componenti del 

computer vengono sottoposte ad un controllo. Questa licenza funziona sempre solamente su un 

determinato calcolatore. Nel caso in cui essa debba essere trasmessa ad un altro calcolatore, oppure se 

vengono modificate troppe componenti del calcolatore provvisto di licenza, essa deve essere emessa di 

nuovo.  

Per ottenere una licenza soft: 

1. selezionate nel menu File: Configurazione generale  -> Registrazione prodotto...  

2. si apre il dialogo che serve alla registrazione licenza (A pagina: 4) 

3. inserite il numero di serie: 

4. cliccate su Ottieni Licenza Software... 

5. si apre la finestra di dialogo Registrazione licenza prodotto.  

Se non lo avete ancora fatto, inserite il numero di serie).  

6. cliccate su Richiesta licenza per registrazione software 

7. indicate i Vostri dati  

8. cliccate su Avanti.  

9. Avete due possibilità di inviarli: 

a) automatico 

 cliccate sul pulsante Invia a  

 selezionate l´organizzazione COPA-DATA desiderata  

 cliccando su OK la richiesta di licenza viene inviata attraverso il Vostro programma di 

posta elettronica. 

 servendovi del pulsante Stampa, potete stampare il Vostro esemplare, oppure 

mandarlo ad un apparecchio fax collegato 

a) manualmente 

 Cliccate sul pulsante Termina   
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 la richiesta di licenza viene salvata come file di testo; una finestra info Vi fornisce le 

informazioni relative a nome e luogo in cui si trova il file. 

 il file viene aperto automaticamebte nell´Editor dei testi 

 inviate il file per E-Mail oppure per fax al Vostro fornitore. 

Non appena avete ricevuto i Vostri dati di licenza, riaprite il dialogo che concerne la licenza e inserite il 

numero di attivazione. 

 

6.2 Licenza dongle 

Nel caso della licenza dongle, per una licenza standalone un dongle viene connesso direttamente al 

calcolatore; per licenze di rete, invece, esso viene connesso ad un computer di rete. zenon  usa due tipi 

di sistemi dongle: 

 Wibu-Key (A pagina: 13) 

 CodeMeter (A pagina: 17) 

Entrambi i sistemi vengono installati automaticamente al momento dell´installazione di zenon. Gli utenti 

che lavorano giá con Wibu-Key, continueranno a ricevere delle nuove licenze per i loro dongle 

Wibu-Key.  

Normalmente, non sono necessarie delle ulteriori impostazioni nel caso di dongle usati localmente. 

L´uso di dongle di rete può rendere necessarie delle configurazioni individuali. Dovete effettuare queste 

impostazioni nel relativo software dongle. Potete leggere i dettagli su questo tema nei capitoli Wibu-Key 

(A pagina: 13) e CodeMeter (A pagina: 17). 

 

6.2.1 Wibu-Key 

Wibu-Key può essere utilizzato su postazione singola o in rete. Il dongle deve essere attivo su una port 

USB oppure port parallela sul computer locale, oppure come server su un computer di rete.  

Per controllare le impostazioni dello stick: 

1. Aprite il pannello di controllo 

2. aprite WIBU-KEY  

3. selezionate lo stick da controllare sul computer locale o in rete 
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per realizzare una lista dei Server-Wibu-Boxen in rete, cliccate sul pulsante Leggi 

4. controllate se il numero nell´ultima colonna della seconda riga è identico con le cifre iniziali dello 

stick. 

 

Ulteriori informazioni concernenti il funzionamento in rete le potete trovare nel capitolo Dongle di rete 

(A pagina: 14).  

 

Dongle di rete 

Per usare Wibu-Key in rete come dongle, server e client devono essere configurati in modo 

corrispondente: 

 Configurazione Server (A pagina: 15) 

 Configurazione Client (A pagina: 15)  

  Attenzione 

WibuyKey usa la porta 22347. Questa porta è impostata in modo fisso e non può 

essere modificata. Tenete presente: 

 Se viene usato un altro firewall rispetto a quello integrato nel sistema 

operativo di windows, questa port deve essere reso disponibile, se volete 

usare Wibu-Key come dongle di rete.  
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Imposta server 

Sul server dongle deve essere attivo il server Wibu-Key. Il server Wibu-Key può essere configurato o 

come applicazione (per esempio avviare tramite Autostart), oppure come servizio. 

Al momento della installazione del software Wibu-Key devono essere selezionate le opzioni 

32 Bit WkNet/WkLAN server di rete 

Installallare come servizio NT con Autostart 

im modo tale che il server Wibu-Key venga installato come servizio (consigliato). 

 

Per avviare il server Wibu-Key-Server come applicazione, deve essere impostata una connessione con il 

file WkSvW32.exe in AUTOSTART di Windows. 

Questo file si trova nella cartella C:/Programme/WIBU-KEY/Server/. 

 

Impostare client 

Devono essere effettuate per il client alcune impostazioni di rete nel pannello di controllo. Fra i 

subsistemi Wibu-Key si procede alla scelta di quale tipo di acceso di rete viene utilizzato. Usiamo 

WkLan. 
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Alla voce Nome server/Indirizzo IP viene indicato o il nome del server, il suo indirizzo IP oppure una 

maschera per l´indirizzo IP. Con "Cerca" la lista viene riempita di tutti i server dongle trovati. 

 

Gli inserimenti vengono esaminati nella successione della lista, e possono essere anche combinati. 

Nel caso in cui come primo inserimento ci sia un determinato server, il sistema verifica se su questo 

computer funziona il servizio server dongle, e se su questo computer c´è un dongle corretto (più veloce!) 

Nel caso in cui non sia stato trovato nessun dongle, e se come prossimo inserimento c`è una maschera 

di filtro, vengono esaminati tutti i computer nella rete, il cui indirizzo IP corrisponde alla maschera. 

Sulla paginaContenuto dovrebbe (dovrebbero) essere indicato (Indicati) il server (o i server) con i dongle 

trovati: 
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6.2.2 CodeMeter 

CodeMeter può essere utilizzato su postazione singola o in rete. La chiavetta USB CodeMeter deve 

essere attiva su una port USB sul computer locale, oppure come server su un computer di rete. La 

Firmware del Dongle deve essere almeno della versione 1.16.  

  Attenzione 

Se il dongle viene rimosso mentre sta lavorando, l´editor si chiude. L´editor si apre in 

modalità demo finché non riconosce una licenza valida.  

Per la configurazione, avviate l´applicazione Administration CodeMeter Centro di controllo facendo 

uso di: Windows Desktop -> Start -> Tutti i programmi -> CodeMeter -> CodeMeter Control Center.   

Il centro di controllo CodeMeter si apre con tre schede: 

Lizenza: contiene informazioni sui dongle trovati. 

Eventi: Mostra il numero degli stick collegati, degli inserimenti di licenza, dei firm-item trovati e di tutti 

gli acessi al CodeMeter Runtime-Server. Per protocollare in modo durevole gli inserimenti, attivate nel 

menu File la voce Salvataggio di. 

Prestito: configura il prestito di licenze. 

LICENZA 
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Parametri Descrizione 

Licenza Elenca tutte i CodeMeter Stick attivi 

Nome Nome individuale dello stick selezionato; può essere 

assegnato facendo uso del pulsante a destra. 

Serien-Nr._ numero di serie dello stick selezionato. 

Versione versione del firmenware dello stick selezionato. 

Stato stato del CodeMeter Stick selezionato. 

Disattiva lo stick connesso è disattivato e non può essere usato da 

nessuna applcazione. 

Attivato finché connesso lo stick è attivato finché è connesso; dopo la rimozione 

dal PC viene disattivato automaticamente. 

Attivato lo stick è completamente attivo e lo rimane anche dopo la 

sua rimozione. 

Sato consigliato: assicura che, nel caso di perdita dello 

stick, delle persone non autorizzate non abbiano la 

possibilità di accedere a licenze e dati personali (per 

esempio: CmPasswordManager). 

  

Attualizzazione della licenza Avvia l´assistente che serve ad aggiungere, modificare e 

cancellare delle licenze. 

Espelli rende possibile la rimozione dello stick. 

Modifica password Permette la modifica della password 

CodeMeter è avviato/CodeMeter è chiuso. Informazione se il servizio CodeMeter funziona o no. Può 

essere modificato nel menu Azione. 

WebAdmin Avvia il browser web con la superficie di amministrazione 

per dongle di rete. A questo scopo deve essere aperta la 

port 22350; per dettagli vedi Amministrazione Rete (A 

pagina: 19).  

 

 

Aggiorna orario certificato 

Potete aggiornare l´orario certificato salvato nel dongle facendo uso del server tempo CodeMeter. A 

questo scopo avete bisogno di un accesso Internet attivo. 
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Per aggiornare l´orario: 

1. Avviate il CodeMeter WebAdmin 

2. Controllate le Vostre Impostazioni di rete (A pagina: 26). 

a) Le impostazioni Proxy in CodeMeter Webadmin sono corrette?  

b) I Vostri dati di accesso sono attuali? 

3. Navigate fino a raggiungere il menu Contenuto -> CmStick 

4. Cliccate sul pulsante Aggiorna  

5. Ottenete l´informazione che, in tal modo, tutti gli stick verranno attualizzati. 

6. Cliccate su OK.  

7. Ricevete un´informazione concernente l´attualizzazione effettuata. Nel caso di una Segnalazione 

di errore (A pagina: 34) controllate soprattutto la correttezza dei Vostri dati di accesso.  

 
 

Administration Rete 

Per avviare Administration in rete, avviate la superficie WebAdmin cliccando sul pulsante WebAdmin in 

CodeMeter centro di controllo. Informazioni dettagliate sulle singole impostazioni le trovate nella guida 

CodeMeter WebAdmin. La potete raggiungere usando il pulsante  Guida in WebAdmin. Le opzioni e le 

indicazioni più importanti le trovate anche in questo documento: 
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 Gestione CodeMeter Sticks (A pagina: 20)  

 Gestione licenze (A pagina: 22)  

 Assicurare dati licenze (A pagina: 22) 

 Impostazioni rete (A pagina: 26) 

 Impostazioni Proxy (A pagina: 26) 

  Attenzione 

Il CodeMeter WebAdmin usa il port 22350. Tenete presente: 

 se viene usato un altro firewall rispetto a quello integrato nel sistema 

operativo di windows, questa port deve essere resa disponibile.  

 Se la port viene modificata, la superficie WebAdmin non può essere più 

avviata, visto che la port è una parte dell´indirizzo, per es.: 

http://localhost:22350/Content.html?BoxSerial=2-1355435  

In questo caso, potete risalire tramite il corrispondente tool freeware o con 

Windows Bordmitteln alla port attualmente usata, e poi potete inserire 

quest´ultima nella riga dell´indirizzo al posto di 22350. Ricambiate poi in 

WebAdmin la Port inserendo 22350. 

 

 

CodeMeter Sticks 

Il WebAdmin si avvia con Contenuto/CmStick. 
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Qui selezionate in una lista a cascata il dongle desiderato, vedete i suoi dati e lo stato come configurato 

nel Centro di controllo (A pagina: 17).  
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Parametri Descrizione 

CmStick Lista a cascata dello stick riconosciuto. 

Nome  Mostra il nome assegnato nel Centro di controllo (A 

pagina: 17). 

Hardware Versione hardware dello stick. 

Primo processore Informazioni sul processore concernenti lo stick; 

dimensioni del processore solo di stick con memoria 

flash. 

Stato Stato di attivazione come definito nel Centro di controllo 

(A pagina: 17). 

Orario certificato (A pagina: 18) L´orario certificato salvato nello stick. Viene aggiornato 

per mezzo del pulsante Aggiorna. 

 per aggiornare per mezzo CodeMeter Timeserver, 

avete bisogno di un accesso Internet attivo. Fate 

attenzione ad effettuare delle corrette Impostazioni di 

rete (A pagina: 26), soprattutto per quello che concerne i 

dati di accesso attuali. 

Tempo box Tempo interno salvato dello stick.  

Sistema tempo Tempo locale del server runtime CodeMeter. 

Memoria libera Memoria disponibile sullo stick. Per defragmentare la 

memoria, cliccate sul pulsante Defragmentare. 

 

 

Licenze 

Le Vostre licenze le gestite nella scheda Licenze che si trova nel menu Contenuto. 

 selezionate il dongle desiderato fra quelli della lista a cascata.  
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 Sotto l´iscrizione Ing.Punzenberger COPA-DATA GmbH trovate le informazioni per le licenze di 

questo dongle.  
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Parametri Descrizione 

Product Code Valore numerico per il prodotto. Cliccando sulla cifra, 

accedete ai dettagli. 

Nome Ing. Punzenberger COPA-DATA GmbH 

Unità d´uso Quando è il caso, visualizzazione delle unità d´uso 

rimanenti. 

Data di scadenza Quando è il caso, visualizzazione della data di scadenza. A 

partire da questo momento, zenon passa in Modalità 

Demo (A pagina: 6).  

Data di attivazione Quando è il caso, visualizzazione della data di attivazione. 

Prima di questo momento, zenon passa in Modalità Demo 

(A pagina: 6).  

Numero delle licenze Numero complessivo delle licenze 

 Cliccate sulla cifra nella colonna Product Code per avere dei dettagli.  

 

Parametri Descrizione 

Dongle Number Deve corrispondere al numero del dongle attivo. 

LIMITI DI DURATA 

Un dongle può essere provvisto anche di un limite di durata:  
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 Data di scadenza  

 Periodo d´uso 

Il dongle viene dotato di una data di scadenza  

Nella scheda Licenze che si trova nel menu Contenuto, viene indicata la data di scadenza nella colonna 

data di scadenza con la data e l´orario in formato UTC.  

 

Il dongle viene dotato di un periodo d´uso. Quest´ultimo inizia a scorrere con il primo uso dell´editor o 

del runtime di zenon. Per controllare il periodo: 

 passate alla scheda Licenze nel menu Contenuto  

 cliccate sull´inserimento alla voce Ing. Punzenberger COPA-DATA GmbH sulla cofra nella colonna 

Product Code 

 Si apre la finestra Product Item Details  
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 Nella cella Periodo d´uso potete vedere il periodo provvisto di una licenza e la data d´inizio con 

orario in formato UTC. 

 
 

Rete e Proxy 

Per assicurare una comunicazione priva di errori con un dongle di rete e l´avvio del WebAdmin, è 

necessario effettuare delle corrette impostazioni di rete. 
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Parametri Descrizione 

Indirizzo di rete Selezione di un indirizzo IP con il quale il server runtime 

CodeMeter si deve collegare.  

Standard: Tutti  

il collegamento avviene con il primo runtime server 

Code-Meter trovato.  

La scelta di un indirizzo specifico è necessaria soprattutto 

se il calcolatore funge da server-licenza di rete e dispone 

di più  

 tessere di rete.  

Port rete Port per la comunicazione CodeMeter nella rete.  

Standard: 22350  

Il valore può essere adattato sulla base delle esigenze 

individuali. In questo caso si deve fare in modo che tutti i 

CodeMeter Runtime-Server usino la stessa port.  

 non modificare port. 

UDP tempo di risposta Massimo periodo di tempo per la risposta nel corso del 

quale una richiesta UDP deve ricevere una risposta.  

Standard: 1000 millesecondi. 

Avvia come server Attivo: Il calcolatore diventa il server di rete 

CodeMetere mette a disposizione le sue licenze in rete. 

Server Lista di ricerca Qui possono essere definiti determinati server di rete 

CodeMeter tramite l´inserimento di nomi calcolatori 

oppure indirizzi IP. Poi il sistema ricerca solamente i 

server che sono stati definiti nella lista. In tal modo è 

possibile far pervenire le richieste di client a server di rete 

CodeMeter definiti. 

 se un server CodeMeter si trova in un´altra 

subrete, usate per la lista di ricerca l´indirizzo IP.  

Questa lista di ricerca dovrebbe essere usata 

solamente se non è possibile trovare lo stick CM in 

rete. 

IMPOSTAZIONI PROXY 
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Per l´accesso a servizi di CodeMeter in Internet come server tempo, inserite in questa sede i dati di 

accesso validi per la Vostra impresa. 

 

 

  Attenzione 

CodeMeter memorizza questi dati di accesso. Se modificate regolarmente la password di 

accesso, dovete modificarla anche nelle impostazioni Proxy del CodeMeter WebAdmin! 
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Richiedi licenza  

Per richiedere delle licenze per CodeMeter o aggiornare delle licenze, selezionate in CodeMeter Centro 

di controllo (A pagina: 17) nella scheda Licenze il pulsante Attualizzazione licenza. L´assistente per 

l´attualizzazione avvia: 

 

Decidete se: 

 richiedere una licenza  

 scaricare un aggiornamento di licenza 

 creare una ricevuta per  COPA-DATA 

 

RICHIESTA LICENZA 

Nel caso di una richiesta di licenza, potete: 

 ampliare una licenza esistente di COPA-DATA 
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 procurarsi una nuova licenza di COPA-DATA  

 

 Per aggiungere una nuova licenza di COPA-DATA: 

 selezionate Ing. Punzenberger COPA-DATA GmbH 

 Per impostare una nuova licenza di COPA-DATA: 

 inserite il CodeMeter FirmCode che avete ricevuto con COPA-DATA.  

 Selezionate il posto dove salvare la Vostra richiesta di licenza. 

 

 

Adatta licenza 

Potete adattare in qualsiasi momento la Vostra licenza in relazione alla sua ampiezza e al Runtime. A 

tale scopo: 

1. ordinate a COPA-DATA il cambiamento desiderato 

2. Riceverete un file *.WibuCmRaU per il Vostro dongle 

3. installatelo: 

a) o con un doppio clic sul file  

b) oppure trascinando il file sul CodeMeter Centro di controllo 

4. Riceverete una segnalazione che Vi informerà del fatto che avete aggiornato con successo la 

Vostra licenza. 

In caso doveste ricevere una Segnalazione di errore (A pagina: 34) 229, ciò significa che la 

licenza sul dongle è già allo stato attuale. 
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Se per la Vostra richiesta concernente la licenza dovesse risultare necessario creare un file 

.WibuCmRaC oppure scaricare manualmente il file .WibuCmRaU con l´update, seguite le indicazioni 

che trovate nella sezione Aggiorna manualmente la licenza (A pagina: 31).  

 

Richiedere o aggiornare una licenza 

Per aggiornare manualmente la Vostra licenza: 

1. create un file .WibuCmRaC  

2. inviate il file a COPA-DATA 

3. Riceverete un file .WibuCmRaU aggiornato 

4. caricatelo sul dongle 

CREARE UN FILE WIBUCMRAC 

1. assicuratevi che il CodeMeter-Dongle sia collegato con il Vostro computer 

2. aprite il centro di controllo CodeMeter, per esempio, tramite Start -> Programmi -> 

CodeMeter -> CodeMeter Control Center 

3. cliccate nella scheda Licenza sul pulsante Aggiorna licenza 

4. l´assistente per l´update si avvia 

5. cliccate su Avanti.  
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6. selezionate Crea richiesta licenza e cliccate su Avanti  

 

7. selezionate Estendi licenza esistente  

8. cliccate su Avanti.  

 

9. nel seguente dialogo cliccate di nuovo su Avanti   

10. selezionate il luogo di salvataggio desiderato per il file .WibuCmRaC corrispondente   

11. cliccate su Applica.  

12. viene generato il file .WibuCmRaC  

13. inviate il file a sales@copadata.com  

INSTALLATE IL FILE WIBUCMRAU 

Riceverete da COPA-DATA un file *.WibuCmRaU attualizzato.  
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Installatelo sul dongle cliccando due volte sul file. 

Alternativa: 

1. aprite il centro di controllo CodeMeter 

2. selezionate "Carica update licenza"  

3. seguite le istruzioni dell´assistente di installazione 
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Correzione errori 

Errore Soluzione 

zenon funziona solamente in 

modalità demo. 
Controllate  

 le Vostre licenze 

 la connessione al dongle di rete 

 se le informazioni sulla licenza (SERIAL7= e ACTIVATIONKEY7=) sono 

state inserite correttamente nello zenon6.ini. Fate attenzione ai 

possibili spazi vuoti dietro il numero di serie (SERIAL7=), oppure la 

key di attivazione (ACTIVATIONKEY7=). 

Percorso per zenon6.ini: 

Vista/7/8: C:\ProgramData\COPA-DATA\System 

Il dongle non viene trovato.  Controllate le Impostazioni di rete (A pagina: 26).  

 Se lo stick si trova in un altro dominio, aggiungetelo alla Lista server 

(A pagina: 26). 

 Aumentate il Tempo di risposta UDP (A pagina: 26).  

 Se si tratta di una macchina virtuale (VM), configurate il memory 

stick come supporto rimovibile (A pagina: 35).  

 la configurazione come supporto rimovibile può anche 

avere come conseguenza (a seconda dalla configurazione del 

calcolatore) che il computer non riesca ad effettuare le operazioni di 

booting e non si avvi.  

 Configurate il  Memory Stick come HID (A pagina: 38).  

Orario certificato non può essere 

aggiornato. 
Controllate: 

 Impostazioni Proxy (A pagina: 26), soprattutto tutti i dati di accesso 

e la password.  

 Lista dei server tempo alla voce Impostazioni -> Server time 

 per es.: cmtime.codemeter.com, cmtime.codemeter.de, 

cmtime.codemeter.fr, cmtime.codemeter.us 

Segnalazione errore nell´update della 

licenza:  

errore nell´update di CmSticks 

x-xxxxxxx:  
questo update non può essere più 

caricato.  Il contenuto di CmSticks 

è a un nuovo stato, erorre 229. 

L´update per questa licenza è stato già trasmesso al dongle. Il 

dongle è allo stato più aggiornato. 
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Il sistema operativo Windows visualizza il 

messaggio: 

Memoria insufficiente 

Il Dongle viene identificato come supporto di memorizzazione 

locale. In alcuni casi, però, si può verificare che il sistema 

operativo segnali "Spazio di memoria insufficiente". 

Questa segnalazione può essere ignorata. 

In alternativa, il Dongle può essere anche configurato come 

supporto removibile. Per i dettagli concernenti la configurazione, 

vedi il capitolo Configurare il Dongle come supporto 

removibile (A pagina: 35).  

 la configurazione come supporto rimovibile può 

anche avere come conseguenza (a seconda dalla configurazione 

del calcolatore) che il computer non riesca ad effettuare le 

operazioni di booting e non si avvi. 

Il sistema operativo Windows non mostra 

più il simbolo del cestino. 

Se il dongle viene identificato come un´unità fissa locale, si può 

verificare questo comportamento.   

In alternativa, il Dongle può essere anche configurato come 

supporto removibile. Per i dettagli concernenti la configurazione, 

vedi il capitolo Configurare il Dongle come supporto 

removibile (A pagina: 35).  

 la configurazione come supporto rimovibile può 

anche avere come conseguenza (a seconda dalla configurazione 

del calcolatore) che il computer non riesca ad effettuare le 

operazioni di booting e non si avvi. 

 

 

Configurare il dongle come supporto removibile. 

La procedura standard è quella di integrare il Dongle nel sistema come supporto di memorizzazione 

locale.  In alcuni casi, ciò può portare al verificarsi di quanto segue:  

 il sistema operativo segnala che esiste troppo poco spazio di memoria per il dongle  

 il simbolo Windows del cestino non viene più visualizzato  

 non viene trovato il dongle in macchine virtuali 

Questo tipo di comportamento del sistema operativo Microsoft non ha alcun effetto sul funzionamento 

di Windows oppure di zenon. Se volete cambiare questo tipo di comportamento, potete configurare il 

Dongle anche come supporto removibile. Non consigliamo di effettuare questa modifica dato che essa 

potrebbe avere come conseguenza il fatto che il computer non è più in grado di effettuare le operazioni 

di booting e non riesce ad avviarsi. 
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  Attenzione 

Nel caso di una configurazione come supporto removibile: 

 si può impedire il booting del computer in quei sistemi che consentono il boot tramite un drive 

USB.  

 il Dongle appare come drive nella taskbar e può essere rimosso (espulso) in qualsiasi momento. 

CONFIGURARE IL CODEMETER DONGLE COME SUPPORTO REMOVIBILE.  

Per cambiare la configurazione di CodeMeter Dongle da unità locale a supporto rimovibile, ci sono due 

metodi:  

 tramite CodeMeter Command Prompt 

 e con il tool CodeMeter Disk Configuration 

1. aprite: 

Start -> Tutti i programmi -> CodeMeter-> Tools-> CodeMeter Command Prompt  

2. leggete la configurazione attuale:  

cmu32 -s <serial> --show-config-disk 

 Nota: <serial> deve essere sostituito con il numero di serie del vostro CmStick, per es. 

1-123456 

3. configurate il CmStick come supporto rimovibile:  

cmu32 -s <serial> --set-config-disk RemovableDisk 

4. rimuovete il Dongle e ricollegatelo di nuovo al computer 

Per riconfigurare il Dongle come unità locale, usate il comando: 
cmu32 -s <serial> --set-config-disk LocalDisk 

Nelle versioni attuali - a partire dalla  4.50 - di CodeMeter, il tool CodeMeter Disk Configuration non 

viene più fornito con il software.  Si può però usare quello fornito con le versioni precedenti.  Se non 

doveste più avere la possibilità di scaricare questo tool di CodeMeter, potete rivolgervi a 

support@copadata.com.  
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Configurazione con CodeMeter Disk Configuration: 

1. aprite CodeMeter Disk Configuration 

 

2. selezionate il Dongle desiderato da  

(il programma mostra solamente i Dongle installati localmente). 

3. aprite la tab Options  
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4. fate un doppio clic nella proprietà Disk Type sull´inserimento  Local Disk 

5. verrà visualizzata una lista a cascata 

6. selezionate l´inserimento Removable Disk 

7. cliccate sul pulsante Apply Changes 

8. rimuovete il Dongle e riconnettetelo di nuovo al computer 
 

Supporto Codemeter HID 

A partire dalla versione 5.0, Codemeter supporta la classe di apparecchi Human Interface Device (HID) 

sello standard USB. In tal modo, Dongle Codemeter possono registrarsi nel sistema invece che come 

memoria di massa (Mass Storage Device), anche come HID (Human Interface Device).  Speciali USB 

Host-Treiber non devono essere installati per configurarli, visto che la funzionalità viene messa a 

disposizione dal sistema operativo.   Il supporto HID è disponibile per tutti i Dongle Codemeter senza 

memoria.  

Requisiti 

 Codemeter Container con l´identificazione "2-xxxxxxx" (Samsung Chips) 

 perlomeno CodeMeter Firmware 2.02 

MEMORIA DI MASSA PER HID 

Per far passare la comunicazione USB da memoria di massa (Mass Storage Device) a Human Interface 

Device (HID):  

1. verificate in CodeMeter WebAdmin lo stato nella scheda Contenuto(CmContainer.  
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2. Un´unità di memoria è assegnata, ma non c´è nessuna memoria flash.   

 

3. Aprite la riga di comando Codemeter cmu: Start -> Programmi-> CodeMeter -> Tools -> CodeMeter 

Command Prompt. 

4. Inserite i seguenti comandi nella riga di comando:  

cmu32 /s [Boxenmaske-numero di serie] --set-config-disk HidCommunication 

5. Lo stato attuale viene visualizzato nella seguente emissione della riga di comando:   

cmu32 - CodeMeter Universal Support Tool. 

Version 5.00 of 2013-Jan-30 (Build 1039) for Win32 

Copyright (C) 2007-2013 by WIBU-SYSTEMS AG. All rights reserved. 

- CmStick/C with Serial Number 2-2251132 and version 2.01 

Versione: 2.01 

Flash Size: no real flash available 

Virtual Drive: E: 

Configuration: LocalDisk with ActivePartition 

File System: FAT32 

Communication: Mass Storage Device 

Boot-Code: Int18 Boot Code 

Mdfa: 0x539 

6. Disconnettere il dongle dal calcolatore.  

7. Ricollegate il Dongle al calcolatore. 
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8. Nel Centro di controllo CodeMeter , e più precisamente nella scheda Eventi verrà segnalato 

il passaggio a HID. 

 

9. Verificate l´unità di memoria in CodeMeter WebAdmin, nella Contenuto/CmContainer.  Non 

deve essercene indicata nessuna.  

 

 

HID PER MEMORIA DI MASSA.  

Per far passare la comunicazione USB da Human Interface Device (HID) a memoria di massa (Mass 

Storage Device):  

1. verificate in CodeMeter WebAdmin lo stato nella scheda Contenuto(CmContainer.  
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2. Nessuna unità di memoria è assegnata.  

 

3. Aprite la riga di comando Codemeter cmu: Start -> Programmi-> CodeMeter -> Tools -> CodeMeter 

Command Prompt. 

4. Inserite i seguenti comandi nella riga di comando: 

C:\Users\fs>cmu32 /s [Boxenmask-Numero di serie] --set-config-disk MsdCommunication 

5. Lo stato attuale viene visualizzato nella seguente emissione della riga di comando:  

cmu32 - CodeMeter Universal Support Tool. 

Version 5.00 of 2013-Jan-30 (Build 1039) for Win32 

Copyright (C) 2007-2013 by WIBU-SYSTEMS AG. All rights reserved. 

- CmStick/C with Serial Number 2-2251132 and version 2.01 

Versione: 2.01 

Flash Size: no real flash available 

Virtual Drive: No drive assigned (HID) 

Communication: Human Interface Device (HID) 

Please replug your CmDongle to apply the changes. 

6. Disconnettere il dongle dal calcolatore.  

7. Ricollegate il Dongle al calcolatore. 
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8. Nel Centro di controllo CodeMeter, nella scheda Eventi viene segnalato il passaggio a MSD. 

 

9. Verificate l´unità di memoria in CodeMeter WebAdmin, nella Contenuto/CmContainer. C´è 

indicata un´unità di memoria, ma non c´é una memoria flash.  

 
 

7. Parametro riga comando per tool di licenza 

Il tool di licenza può essere gestito tramite la riga comando con i seguenti flag come parametro: 

L'assunzione dei parametri avviene mettendo davanti al parametro un '/' oppure un '-'.  

Per es.: /silent oppure -silent 
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Parametri Descrizione 

request Costringe il programma a non visualizzare il primo dialogo; al suo posto appare 

subito il dialogo che richiede l'indicazione della chiave di attivazione  

(non ha alcuna importanza se è in uso il flag  /silent oppure –silent) 

sernum:<num> Costringe il programma a non leggere il Numero di serie dal file  zenon6.ini 

, ma ad usare il <num> indicato per la licenza. 

actkey:<key> indicato per la licenza.  Chiave di attivazione dal file zenon6.ini, ma ad 

usare la<key>  indicata per la licenza. 

silent Costringe il programma a non visualizzare alcun dialogo. Tuttavia il file License.txt 

viene scritto. 

mailto:<addr> Funziona solo  in collegamento con il flag 'silent'  e costringe il programma 

a mandare la richiesta di licenza per E-Mail all'indirizzo <addr> indicato. 

 

 

8. Registrazione licenza remota 

Per assegnare una licenza ad un calcolatore via collegamento remoto: 

1. selezionate nel menù contestuale del progetto Remote-Transport -> Cambia la password e visualizza 

la licenza  

2. avviate il Remote-Transport 

3. non appena la connessione è instaurata, appare la licenza del calcolatore remoto 

 

4. inserite il numero di serie e quello di attivazione del Vostro documento di licenza 

5. confermate l´inserimento cliccando su OK 
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9. Particolarità concernenti il funzionamento 
Server-Client. 

Per quanto concerne la licenza di moduli nel funzionamento Server-Client, si fa presente che esistono le 

seguenti particolarità: 

ARCHIVIAZIONE 

Si distinguono i seguenti casi: 

 licenze per Server e per Client: gli archivi possono essere aperti e ci si può lavorare sul Client. 

 Licenza per il Server, niente licenza per il Client: gli archivi possono essere aperti sul Client, ma 

non li si può modificare in questa sede. 

 Licenza per il Client e standalone avviato: la finestra archivi può essere aperta, ma non i singoli 

archivi. 

AUTOMATIC LINE COLORING 

Si distinguono i seguenti casi: 

 Licenza per il Server, niente licenza per il Client: la funzionalità ALC è disponibile senza alcun tipo 

di limitazione. 

 Licenza per il Client e standalone avviato: la funzionalità ALC non è disponibile. 

  Informazioni su 

Se è disponibile una licenza del Server per la Energy Edition, anche ALC dispone di una 

licenza. 

BATCH CONTROL 

Il client si va a prendere la licenza dal server e non ha bisogno di una licenza propria. Se il server non 

dispone di una propria licenza, il client non è in grado di utilizzare il modulo. 
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ENERGY MANAGEMENT SYSTEM 

Si distinguono i seguenti casi: 

 Licenza per il Server, niente licenza per il Client: la funzionalità EMS è disponibile senza alcun tipo 

di limitazione. 

 Licenza per il Client e standalone avviato: la funzionalità EMS non è disponibile. 

MESSAGE CONTROL 

Il client si va a prendere la licenza dal server e non ha bisogno di una licenza propria. Se il server non 

dispone di una propria licenza, il client non è in grado di utilizzare il modulo. 

Il everywhere Server  si va a prendere la licenza dalla dal Runtime e non ha bisogno di una licenza 

propria. Se il Runtime non dispone di una licenza corrispondente, non si potrà usare l´Everywhere 

Server.  

Per questo motivo può succedere che il Runtime funziona, ma l´Everywhere Server non può essere 

avviato per la mancanza delle necessarie autorizzazioni di licenza.  In questo caso usate il tool di 

registrazione licenza (A pagina: 4) per ottenere la licenza di cui avete bisogno.  
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